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Preface 

 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

 

Intended Audience 

This User Guide is intended for the following audience: 

 Persons in charge of introducing automation devices. 

 Persons who design automation systems. 

 Persons who install or connect automation devices. 

 Persons who manage working automation installation. 

 

 

 

 

 

  Warnings: 

 Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

 Improper use of this product may severely damage the controller. 

 Refer to the controller’s User Guide regarding wiring considerations. 

 Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 
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Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

 Systems, machines, and equipment that could present a risk to life or property. 

 Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machine, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

 Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 
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Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

 

Performance Data 

Performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 

 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 
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Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESS 

OR IMPLIED, REGARDING MERCHANABILITY, NON-INFRINGEMENT, OR 

FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. ANY BUYER OR 

USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE HAS DETERMINED 

THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR 

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, 

EXPRESS OR IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANY, NEGLIGENCE, OR STRICT LIABILITY. 

If no event shall the responsibility of INDUSTRIAL SHIELDS for any act exceed the 

individual price of the product on which liability is asserted. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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1. ARDBOX 

A compact PLC based in Open Source Hardware technology. With different 

Input/Outputs Units. 

 

 

 

 

 

 

                                                           
1 Pull-up resistance required for i2c (IS.ACI2C-4.7K) 

COMPACT PLC ARDUINO 12-24Vdc ARDBOX 
ANALOG HF 

 

Supply Voltage 12-24Vdc 
Fuse protection (2.5A) 

Polarity protection 
 

Max. current consumption 1,5A  

Size 100x45x115  

Clock Speed 16MHz  

Flash Memory 
32KB of which 4KB are used by 

bootloader 
 

SRAM 2.5KB  

EEPROM 1KB  

Communications 
I2C1  – USB -- RS485 Half/Full 

Duplex(Modbus) –SPI 
 

TOTAL Input points 10  

TOTAL Output points 
10 
 

 

INPUTS 

 
Digital range:12 to 24 Vdc (7.6 to 

25.4 Vdc) 
 

Analog range: 0 to 10 Vdc 
 
 

 
 

Digital 10 

 
12 to 24Vdc 
I min: 3/6 mA 

Separated PCB ground 
 

Analog 10 bits  9 of 10 Digital input 

 
0 to 10V 

Input Impedance: 78K 
Separated PCB ground 

 

* Interrupt HS  1 of 10 Digital input  

 
12 to 24Vdc 

I min: 5/10 mA 
Separated PCB ground 

 

*The same input is not simultaneously compatible as InterruptHS and 
Digital. IMPORTANT 

 

http://www.industrialshields.com/Industrial%20Pull%20UP%20I2C%20connection
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2. Precautions 

Read this manual before attempting to use the Ardbox and follow its descriptions for reference 

during operation. 

 Arduino Board 

All Ardbox family PLCs include Arduino LEONARDO Board as controller.  

 Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

 General Precautions 

The user must operate Ardbox according to the performance specifications described in this 

manual. 

Before using Ardbox under different conditions from what has been specified in this manual or 

integrating Ardbox to nuclear control systems, railroad systems, aviation systems, vehicles, 

combustion systems, medical equipment, amusement machines, safety equipment and other 

systems, machines, and equipment that may have a serious influence on lives and property if 

used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and 

performance characteristics of Ardbox are sufficient for the systems, machines, and equipment, 

and be sure to provide the systems, machines, and equipment double safety mechanisms. This 

manual provides information for programming and operating the Ardbox.  

OUTPUTS 

 
Digital Isolated range: 5 to 24 Vdc 

(4.6 to 25.4 Vdc) 
 

Analog range: 0 to 10 Vdc 
 

 

Digital Isolated 10 

 
5 to 24 Vdc 
I max: 0.3 A 

Galvanic INSULATION 
Diode Protected for 

Relay 
 

Analog 8 bits  7 

 
0 to 10 Vdc  

I max: 40 mA 
Separated PCB ground 

 

PWM Isolated 8bit 6 of 10 Digital isolated Output 

 
5 to 24 Vdc 
I max: 0.3 A 

Galvanic INSULATION 
Diode Protected for 

Relay 
 

Expandability 
I2C - RS485 Half/Full Duplex 

(Modbus) - SPI 
 

Reference 
IS_AB20ANA.HF 
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3. Technical Specifications 

 

 General Specifications: 

Power supply 
voltage 

DC power supply    12 to 24Vdc 

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc 

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply voltage 12 to 24Vdc 

Power supply output 
capacity 

700Ma 

Insulation resistance 
20MΩ min.at 500Vdc between the AC terminals and the protective earth 
terminal. 

Dielectric strength 
2.300 VAC at 50 to 60 HZ for one minute with a leakage current of 10mA 
max. Between all the external AC terminals and the protective earth 
terminal. 

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 45ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 
340g max. 

 

 

 

 Performance Specification: 

Arduino Board ARDUINO LEONARDO 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform 
composed of a programming language. “similar to the C”.  
http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega32u4 

Flash Memory 32kb of which 4Kb are used by bootloader 

http://arduino.cc/en/Tutorial/HomePage
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Program capacity (SRAM) 2.5kb 

EEPROM 1kb 

Clock Speed 16MHz 

4. Software interface 

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Furthermore Industrial Shields provides boards for programming the PLCs much easier. 

Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is 

set up automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.0 or above (better to have always the latest version). 

Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json
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3. Press OK to save the changes. 

 

4. Go to: Tools -> Board: … -> Boards Manager 

 

 

5. Search for industrialshields on the searcher. 

 

 

 

 

 

 

 

 

 

 

 

6. Click install (selecting the latest version). 

 

Following this steps you will be able to use now the Industrial Shields Boards: 
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Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools: 

There, it can be selected the exact model for every family. 

 

 

Also there are some examples of programming in File -> Examples -> Ardbox Family. 

Furthermore there are some extra libreries that can be found in Industrial Shields github. 

https://github.com/IndustrialShields/ 

 

https://github.com/IndustrialShields/
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5. How to connect PLC Arduino to PC 

 

- Connect USB port from PLC to PC. 

NOTE:  
Ardbox Family use micro USB cable.  
 
 
 

- Open Arduino IDE interface: 
 

- Select Industrial Shields boards -> Ardbox Family 
 

- Select the correct Ardbox Relay Board. 
 

 
 

 
In order to use the correct board, Ardbox Analog HF is the option that must be selected. 
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- Select correct port. 

 

 

 

Now everything is set up to upload a sketch to Ardbox Relay HF 

6. How to connect PLC to power supply 

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 
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- Suggested power suppliers

  

 

 

7. Ardbox Analog  I/O Pinout: 

 Zone Connections 

 

 

 

 

 

 

RIGHT Zone 

A
rd

b
o

x
  

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

F
u

n
c
ti
o

n
 

A0.6 
A0.5 
A0.4 
A0.3 
A0.2 
A0.1 
A0.0 

 
Q0.9 
Q0.8 
Q0.7 
Q0.6 
Q0.5 
Q0.4 
Q0.3 
Q0.2 
Q0.1 
Q0.0 

 
GNDCOM 
24VCOM 

3 
5 
6 

9 
10 
11 
13 
 
0 
1 
7 
3 
5 
6 
9 
10 

11 
13 
 
- 
- 

Analog Out 
Analog Out 
Analog Out 
Analog Out 
Analog Out 
Analog Out 

Analog Out Digital  
 

Output  
Digital Output  
Digital Output 

PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 
PWM/digital Output 

 
Isolated GND 
Isolated VIN 

* Not recommended for industrial applications. The 

Jack connector needs to be removed and use the live 

and GND connectors.   

 

RIGHT Zone 

 

 

 

 

 

Switch config*  

(see section 9 for Analog/Digital 

Outputs configuration) 
 

 

Analog Outputs pinout 

 

 

 

 

 

Digital/PWM Output pinout 

 

 

Isolated VIN/GND for Outputs 

 

Power supply connectors  

1. Din RAIL 

Power 

Supply, ac-dc, 

30W, 1 

Output 1.3A 

at 24Vdc 
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LEFT Zone 

A
rd

b
o

x
  

C
o

n
n

e
c
to

r 

A
rd

u
in

o
 P

in
 

F
u

n
c
ti
o

n
 

A+ 
B- 
Y+ 
Z- 

SCL-PIN3 
SDA-PIN2 

NC 
NC 
5V 

RESET 
SCK 
MOSI 
MISO 

 
I0.9 

 
I0.8 

 
I0.7 

 
I0.6 

 
I0.5 

 
I0.4 

 
I0.3 

 
I0.2 

 
I0.1 

 
I0.0 

- 
- 
- 
- 
3 
2 
- 
- 
- 
- 
- 

- 
- 
 

A0 
 

A1 
 

A2 
 

A3 
 

A4 
 

A5 
 

4 / A6* 
 

8 / A8* 
 

12 /A11* 
 
2 

RS485(A) 
RS485(B) 
RS485(Y) 
RS485(Z) 
SCL(I2C) 
SDA(I2C) 

- 
- 

5Vout DC 
RESET 

SPI 
SPI 
SPI 

 
Analog/Digital 

Input 
Analog/Digital 

Input 
Analog/Digital 

Input 
Analog/Digital 

Input 
Analog/Digital 

Input 
Analog/Digital 

Input 
Analog/Digital 

Input 
Analog/Digital 

Input 
Analog/Digital 

Input 
Digital interrupt 

LEFT  Zone 

 

 

 

Switch config*  

(see  section 9 for Switch configuration. 

Enabling Communications disables 

some I/Os) 

 

 

 

 

 

 

Communications pinout 

(SPI, I2C, RS485, RS232) 

 

 

 

 

Inputs pinout 

 

     Switch                                         Input / Output              Power LED          Arduino Reset  

                                                                                                                                             button 

                                                                          

                 

 
Configuration switch* (see section 9 for communications configuration) 

*Use A6, A8 and  A11 for  analog values 
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8. Switch configuration 

General Switches Configurations 

 

 

 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
*IMPORTANT:  
  
LEFT ZONE. To enable I2C communication connections the switches of the I2C (SCL, SDA) must be set to 
“OFF”. Set to “ON” position to enable I/Os  PLC connection (I0.0, Q0.6).  To enable RS485 communication 
connections the switch of (DE-RS485) must be set to “ON” and the switch of A0.2-Q0.2 must be “OFF”. 
The contrary configuration will enable A0.2-Q0.2 and it will disable RE-RS485. Communications and I/Os 
on the chart can not work simultaneously. For exemple if DE is enabled (ON),  Q0.2 will not work. 
 
RIGHT ZONE. The right zone configures the outputs. If the switch is set to “ON” the Q0.X will have the 
behaviour of a digital output. If it is set to “OFF” it will be digital. There is also a switch for switching 
between Half and Full Duplex. It is “ON” for HD and “OFF” for FD. 
 
TOP ZONE.  Communications and outputs can not work simultaneously. If Q0.9 is enabled RO must be 
disabled and vice versa. It is also the same implementation for the Q0.8 – DI. 
 

 RS- 485 Switch configuration 

 

 

 

 

 

 

RS485: Enable RE/DE/DI and RO internal pins with configuration switches. A0.2, A0.1, Q0.2, 

Q0.1, Q0.8 and Q0.9 will not be available. The defined Arduino Mega pins for RS485 are 

showed in the chart below. 

LEFT ZONE 

SWITCH CONFIGURATION 

ARDUINO PIN OFF* ON 

10 A0.2-Q0.2 DE-RS485 

10 DE-RS485 A0.2-Q0.2 

11 A0.1-Q0.1* RE-RS485 

11 RE-RS485 A0.1-Q0.1* 

2 SCL-D2 I0.0 

3 SDA-D3 Q0.6 

RIGHT ZONE 

SWITCH CONFIGURATION 

ARDUINO PIN PLC PIN OFF ON 

- H/F Full Duplex Half Duplex 

3 Q0.6 ANALOG DIGITAL 

5 Q0.5 ANALOG DIGITAL 

6 Q0.4 ANALOG DIGITAL 

9 Q0.3 ANALOG DIGITAL 

10 Q0.2 ANALOG DIGITAL 

11 Q0.1 ANALOG DIGITAL 

13 Q0.0 ANALOG DIGITAL 

TOP ZONE 

ENABLED CONNECTION ON OFF 

Q0.9 Q0.9 RO 

RO RO Q0.9 

Q0.8 Q0.8 DI 

DI DI Q0.8 

RS-485 CONFIGURATION 

TOP ZONE LEFT ZONE 

 Q0.9 OFF DE-RS485 ON 

RO ON A0.2-Q0.2 OFF 

Q0.8 OFF RE-RS485 ON 

DI ON A0.1-Q0.1 OFF 

  SDA ON/OFF 

  SCL ON/OFF 



       
P

ag
e2

0
 

 I2C Switch configuration 

 

I2CCONFIGURATION 

TOP ZONE LEFT ZONE 

Q0.9 ON/OFF DE-RS485 ON/OFF 

RO ON/OFF A0.2-Q0.2 ON/OFF 

Q0.8 ON/OFF RE-RS485 ON/OFF 

DI ON/OFF A0.1-Q0.1 ON/OFF 

  SDA OFF 

  SCL OFF 

 

I2C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. I0.0 

and Q0.6 will not be available. In order to implement this communication a 4.7kΩ pull-up 

resistor (IS.ACI2C-4.7K) is required. 

 Analog/Digital Output Switch Configuration 

 

RIGHT SIDE 

SWITCH CONFIG 

Output ON OFF 

H/F 
Half 

Duplex 
Full 

Duplex 

Q0.6 DIGITAL ANALOG 

Q0.5 DIGITAL ANALOG 

Q0.4 DIGITAL ANALOG 

Q0.3 DIGITAL ANALOG 

Q0.2 DIGITAL ANALOG 

Q0.1 DIGITAL ANALOG 

Q0.0 DIGITAL ANALOG 

9. Communications 

 SPI 

The Ardbox pins used for the SPI bus are summarized in the table below. For SPI bus MISO, 

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely, 

each of the connected devices will have a single and dedicated SS pin. 

Function Ardbox connection Mega board pin 

MISO  MISO MISO 

MOSI  MOSI MOSI 

CLOCK  SCK SCK 

Reset RESET Reset 

SS SCL (pin 3)/SDA (pin 2)/DE (pin 7)/ RE(pin  4) pin 3 /pin 2 /pin 7/pin  1 

 

Check the switch configuration at section 8 to enable SS pins. 

http://www.industrialshields.com/Industrial%20Pull%20UP%20I2C%20connection
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Check the link to see an example: http://blog.industrialshields.com/en/how-to-upload-a-

bootloader-on-a-ardboxm-duino-plc/ 

 

 

 RS-485 

For RS485 communication protocol the defined Arduino Mega pins are showed in the 
chart below. 
 

RS485 pinout 

Function Arduino Pin 

DI 10 

RO 11 

RE 1 

DE 0 

 
Check the switch configuration at section 9 to enable RS485 pins 

 

Check the link to see an example: http://blog.industrialshields.com/en/rs485-communication/ 

 

 

 

10. I/0 technical details 

 

Digital Output Waveform 

 

 

 

 

 

 

 

Digital Output Turn-off 

http://blog.industrialshields.com/en/how-to-upload-a-bootloader-on-a-ardboxm-duino-plc/
http://blog.industrialshields.com/en/how-to-upload-a-bootloader-on-a-ardboxm-duino-plc/
http://blog.industrialshields.com/en/rs485-communication/
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PWM Waveform 

 

 

 

 

 
Analog Out Turn-on 

 

Analog Out Turn-off 
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Analog/Digital Input Turn-on 

 

 
 
 
 
 
 
 
 
 
 
Analog/Digital Input Turn-off 
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11. Typical Connections 
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P

ag
e2

6
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12. Connector details 

 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

 

Connection details: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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13. ARDBOX Family Dimensions: 

14. DIN rail mounting: 

15.  

 

  

 

45mm width 
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About Industrial Shields: 
 
Direction: Fàbrica del Pont, 1-11 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 

mailto:industrialshields@industrialshields.com

